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CHAIRMAN’S CHAT  
 

Term 1, 2010 
 

The reason I am writing this that I 
have had my arm twisted, but let 
me put you in the picture.  As you 
may recall, in May last year our 
elected Chairman Hunt Dryburgh, 

went into hospital for surgery. This took him out of 
action and our Secretary at the time, Laurie Davies 
assumed the roll of acting Chairman. 
 
Hunt‘s recovery took much longer then anticipated 
and although he is much better now, he is not yet 
ready to resume his former roll. Meanwhile Laurie 
kept us all going until the end of Term 4 when he 
himself also needed medical attention. 
 
As a result of these circumstances the 
management committee again found themselves 
without a helmsman at the beginning of the New 
Year. 
 
By some common consensus at our 1

st
 meeting in 

January I drew the short straw to act on behalf of 
Laurie and front up to the task. 
Since that time the committee have all pitched in 
and got Term 1 organised and off to a good start.  
 
It was quite gratifying to see so many new faces at 
our first ―Open Day‖ for the year in January and we 
gained two new Introductory classes out of that 
event as well as renewals of members wishing to 
do further courses. 
 
Term 1 is now getting into the final stages and all 
courses will have finished before Easter. Besides 
the two ―Intro‖ classes we have had the following 
courses, ―Word processing 1 and 2‖, ―Email and 
Internet‖ (2 courses of four weeks each), ―Spread- 
sheets‖ and ―Digital Camera and Photo editing‖. 
 

We have also conducted a series of 2 hour 
Workshops, such as Computer Care and 
Maintenance, ―Use of Flash Drives‖, ―CD/DVD 
burning and File transfer‖ and last but not least, 
―Trade Me‖ for those bargain hunters amongst us. 
 
The Digital Camera Interest group has also been 
active. Ron Dunbar had arranged an unusual and 
very interesting trip to the ―Mainland Steam‖ 
workshops in Plimmerton. Here our photographers 
were let loose amongst a fascinating collection of 
(full sized) Railway locomotives, Carriages and all 
sorts of impressive machinery. 
 
It was a worthwhile trip as the railway workshops 
are quite out of sight from the road and you 
wouldn‘t know they were there unless you got onto 
the platform at Plimmerton Station. We all had fun 
at the next meeting showing off unusual shots we 
had taken that day. Ron won the competition this 
time with his fine shot of one of the steam 
locomotives. 
 
By the time you receive this newsletter we will 
have had our AGM. It is encouraging to see that 
nearly all the current committee are standing again 
and we now have a couple of new members... 
 
At the AGM we had secured Mr. Bill Brown, a 
gentleman from the ―Need a Nerd‖ company who 
was our guest speaker. As we all could do with 
one of those types of experts from time to time, 
this gave us an interesting insight into home 
computer problems and what to do about them. 

 
 
Peter Badart 
Chairman 
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SENIORNET - END OF TERM 1 
 

 

Thursday 
 

 

1 April 

 

 
 
 

APPLICATIONS CLOSE FOR TERM 2 
 

 

Wednesday 
 

 

14 April 

 
 
 
 
 
 

 
SENIORNET - START OF TERM 2  
 

 

Monday 
 

 

3 May 

 

 

 
PUBLIC HOLIDAYS 
 

 
Friday - Monday 

 
2 – 5 April 

 
Easter 

 
 

 
 

 
 
 
 
 

ARTICLES FOR NEXT NEWSLETTER 
 
Would you like to contribute anything to our 
next newsletter?  If so, you have plenty of 
time. Computer tips, funnies (not too long) 
small cartoons etc will be great.  
 

The next newsletter is not until June so send 
your contributions to: margots@xtra.co.nz   
And please put ‗SeniorNet Newsletter‘ in the 
Subject line.   
 
They will of course be subject to space - but 
you never know - it could appear in an issue – 
so look out for it. 
 
 
 
 

I know I’m in my own little world, but it’s ok.  
They know me here. 

 
 

 
 
 
 
 
 

AN OPEN DAY WILL BE HELD   
 

Tuesday 13 April 
 

 Where: Ngati Toa School 
 

 Piko Street, Titahi Bay 
 Room 2 
 
 

   Time: 9.30am – 12.30pm 
 

 You are all welcome to attend 
 and - please bring a friend. 

 

 * Come and talk to our tutors 
 * Receive Assistance 
 * Check out the equipment 
 *   Friendly atmosphere 
    

Light refreshments will be served   
 
 
 

 
A VERY WARM WELCOME TO   

NEW MEMBERS FOR TERM ONE 
 

 
 
 
 
 
 

 
Margaret Allan Phyllis Armstrong  
Ian Catherall Alan Ellis  
Dave Fawcett  Drew Fittes  
Valerie Harding Jim Harper 
Dawn Jamieson Jerry Le'aupepe  
Patricia Maddocks  Chas McMahon  

Sylvia Paget Mirren Sanderson  
Avis Steed Fred Steed  
Margaret Stewart Adrian Tiavaasue 
Phyl Toomath Kathleen Williams  
Valerie Wilton Jan Wright 
 

 

mailto:margots@xtra.co.nz
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DO YOU NEED A NERD? 
 

We all 
need help 
at some 
stages with 

the technical stuff, and it would be great to 
have a ―nerd‖ on hand to fix it all up!  
 
In steps a new company called Need a Nerd, 
fixing and installing computers, TVs and home 
entertainment is their speciality, they are 
offering special discount prices for all our 
SeniorNet members. Go and take a look at the 
article in the ―What‘s New‖ section of 
www.seniornet.co.nz also click onto the Need 
a Nerd banner to find out more. Need a Nerd 
have just come onboard as a SeniorNet 
partner.  
 
 

 
 

 
HUMOR FOR LEXOPHILES 
(LOVERS OF WORDS) 

 
Did you hear about the guy whose whole left 
side was cut off? He's all right now. 
 
The short fortune teller who escaped from 
prison was a small medium at Large. 
 
A thief fell and broke his leg in wet cement. He 
became a hardened Criminal. 
 
When the smog lifts in Los Angeles, U.C.L.A 
 
The butcher backed up into the meat grinder 
and got a little behind in his Work. 
 
 
 

 
 
 

Serious Error, All shortcuts have disappeared 
Screen …. Mind …. Both are Blank 

 
 
 

 
 

Thanks to Term One Tutors  

 
Introduction to Computers 
Enid Alexander Graham Alexander 
Ron Dunbar  Keith Wood 

Word Processing – Level 1 
Margot Stuart 

Word Processing – Level 2 
Margot Stuart  Sean O‘Neil 

Spreadsheets 
Graham Ellett   
 
Digital Camera & Photo Edit 
Peter Badart 

Workshops 
Peter Badart  Ron Dunbar 
Margot Stuart 

Email and Internet 
Bob Pretty  Peter Phipps 

 
 

 

http://www.seniornet.co.nz/
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 MICROSOFT WORD HELP 
 
How can I find out the names of the 
buttons on the toolbars? 
 
Hover the mouse over any button and its 
name will appear in a box near the mouse 
pointer. 
--------------------------------------------------------- 
 
How can I display more toolbars? 
 
1. Choose Toolbars from the View menu. 
2. Select the toolbar you want (an active 

toolbar has a next to its name). 
--------------------------------------------------------- 
 
To remove a button from the toolbars: 
 
1. Choose Toolbars from the View menu. 
2. Select Customize. 
3. Drag the button you want to remove off of 
the toolbar. 
--------------------------------------------------------- 
 
Can I make my own toolbars? 
 
Yes! To make your own toolbar: 
 
1. Choose Toolbars from the View menu. 
2. Select Customize. 

3. Click on the Toolbars 
tab, then click on the 
New button. 

4. Give the toolbar a 
name. You can also 
choose to make this 
toolbar available to 

the Normal template (all documents) or 
the current document only. A small toolbar 
palette will appear on the screen. Click on 
the Commands tab, select a Category, 
then drag the commands you want onto 
your new toolbar. 

--------------------------------------------------------- 
 
How do I change the default margins? 
 
1. Choose Page Setup from the File menu. 
2. Click on the Margins tab. 
3. Set the margins the way you want them, 

then click on Default. Word will inform you 
that this change will affect all documents 
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based on the Normal template. 
 

How do I change the default document 
font? 
 
1. Choose Font from the Format menu, then 

set all of the attributes you want for your 
default font. 

2. Click the Default button. 
3. Word will inform you that this change will 

affect all documents based on the Normal 
template. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

LENDING LIBRARY 
 

In our classroom we have a selection of books 
to lend out to members.   
 

If you would like to borrow one or more of our 
books for a reasonable time, there is a 
notebook on the shelf where you can put in 
your details, the name of the book borrowed 
and the date.   
 
 

 

 

 
 

You're the computer,  
YOU tell ME where the file is! 
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THE UNSTOPPABLE VIRUS 
 
I thought you would want to know about this  
e-mail virus.  Even the most advanced 
programs from Norton or McAfee cannot take 
care of this one. 
 

It appears to affect those who were born prior 
to 1965 
 

Symptoms 
 

Causes you to send the same e-mail twice - 
Done that 
 

Cause you to send a blank e-mail - That too! 
 

Causes you to send e-mail to the wrong 
person -Yep! 
 

Causes you to send it back to the person who 
sent it to you - Aha! 
 

Causes you to forget to attach the attachment 
Well darn! 
 

Causes you to hit SEND‖ before you‘ve 
finished - Oh, no - not again! 
 

Causes you to hit ―DELETE‖ instead of 
―SEND‖ - And I just hate that! 
 

Causes you to hit ―SEND‖ when you should 
―DELETE‖ – Oh- No!  
 
IT IS CALLED THE ......."C-NILE VIRUS"  
 
Hmmmm….Have I already sent this to you?  

 

 
 

 
 

Printer not ready 
Could be a fatal error 
Have a pen handy? 

 
 

USING KEYBOARD CONTROLS ON A 
WORD DOCUMENT 

Insert WordArt with the keyboard 

1. Press and release ALT, then I, then P, 
then W to select WordArt.  

2. Use the arrow keys to select the WordArt 
style that you want, and then press 
ENTER. 

3. Type the text that you want. 

------------------------------------------------------- 

Insert a Text Box by using the keyboard 

Press and release ALT, then I, then using the 
vertical arrow  down to Text Box, and press 
CTRL+ ENTER.  

Type the text you want in the text box and 
when you have finished typing and want to 
switch back to editing text in your document, 
press SHIFT + F10, choose Exit Edit Text on 
the shortcut menu with your vertical arrow key 

------------------------------------------------------- 

Change the size of a drawing object by 
using the keyboard 

1. First you must select the object you want 
to change. 

2. Use the keyboard to choose the command 
for the type of object you selected 

3. For example, on the Format menu, 
choose AutoShape or Text Box — and 
then select the Size tab. 

4. Select the options you want. 

------------------------------------------------------- 

 
A LITTLE TONGUE TWISTER TO 
ACTIVATE THE BRAIN 
 

A skunk sat on a stump and thunk the stump 

stunk, but the stump thunk the skunk stunk. 
 

javascript:ToggleDiv('divExpCollAsst_52')
javascript:ToggleDiv('divExpCollAsst_52')
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ARRANGING TOOLBARS 

Most programs you use will have a Title bar, 
Menu bar, and Toolbars along the top. The 
exact appearance of these things will vary 
from one program to the next. But their 

purpose is generally the same in all programs: 

Also, many programs have toolbars that you 
can size and position within the program 
window. You can also lock the toolbars, to 
avoid accidentally rearranging them after you 
get them arranged the way you like.  

You can tell if the toolbars are currently locked 
or unlocked just by looking at them. If the 
toolbars are locked, you'll see a handle (also 
called a dragging handle or sizing handle) to 
the left of each toolbar.  

The handle is just a vertical column of dots, as 
in the top half of 
Figure 4. When the 
toolbars are locked, 
the handles aren't 
visible, as in the 
bottom half of that 

same figure. 

 

NB. Unlocked toolbars (top picture) shows the 
dragging handles which are the vertical dotted 
lines 

If the toolbars are currently unlocked, choose 
View 
Toolbars 
Lock the Toolbars to lock the toolbars 

 If the toolbars are currently locked, choose 
View 
Toolbars 
Lock the Toolbars to unlock the toolbars. 

When the toolbars are unlocked, it's easy to 
accidentally rearrange them, as in the 
example shown below where the Address 
toolbar is now squished off at the right side of 
the Standard Toolbars button. 

 

Now the Standard buttons and Address bar 
are on same row 

To get the Address bar back to its own row, 
you first need to make sure you can see the 
sizing handle. Notice that when you point to 
(rest the tip of the mouse pointer on) the 
sizing handle, the mouse pointer turns to a 
two headed arrow, as in the below example. 

 

Mouse pointer on handle 

 
Whenever the mouse pointer changes to 
arrows like that, it means "drag to move or 
size". If you drag that handle straight down a 
little, and over to the left, you can put the 
Address bar on its own row, as in below.  

 

Standard Buttons and Address bar  
are now on separate rows 

When you have the toolbars arranged the way 
you like in a program, you can lock them. That 
way you won't accidentally move them while 
you're whipping around the screen with your 
mouse. Note that you can show or hide 
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toolbars whether the toolbars are locked or 
unlocked. But if you want to move or size the 

toolbars, you need to unlock them first. 

  
 

 
 
 
 
 
 
 
 

 

Dasi, Dasi 

(Song - to A Bicycle Built For Two) 
 
Dasi, Dasi, give me my output, do. 
I'm half crazy waiting for you to get through. 
I don't understand why it's taking 
So long for the process I'm making. 
I don't ask much 
But it is such 
A bore sitting waiting for you. 
 

 
 

 
 
 
 

 

 
 
BOOK YOUR HOLIDAY 

 
Travel 
Interislander – Maximum 
baggage allowed 
www.interislander.co.nz  
 
 

Car Rentals 
Thrifty 
www.thrifty.co.nz  
 
GPS 
TomTom 
www.tomtom.com  
 

http://www.interislander.co.nz/
http://www.thrifty.co.nz/
http://www.tomtom.com/
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Real Time Traffic Information 
For AA Members 
www.aatraffic.co.nz 
 
AA Travel Bookings 
www.aatravel.co.nz  
 
Escorted Tours 
www.pukekohetravel.co.nz 
 

 
 
Places to stay 
Golden Chain Motels 
www.goldenchain.co.nz  
 
Main Hotels 
www.mainstay.co.nz  
 
NZ Hostel 
www.yha.co.nz 
 
Cottages & Unique Places to stay 
www.cottagestays.co.nz  
 
Holiday Parks 
www.top10.co.nz 
 

 
 
Thrill Seekers Adventures 
Jet, Bungy, Rafting, Quad Bikes 
www.thrillseekers.co.nz   
  
  

 
 

 
 
 
 
 
 
 
 
 
 

 

 
 
Ever stop to think, and forget to start again? 

 
 

Wrinkled was not one of the things I  
wanted to be when I grew up 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
  
 

 

 
 
USEFUL INFORMATION SITES 
 
 
Human rights Commission 
www.hrc.co.nz  
 
Ministry of Consumer Affairs 
www.consumeraffairs.govt.nz  
 
Tenancy Agreement 
All information about your rights and 
obligations 
www.dhb.govt.ns/tenants-index  
 
Kohanga Reo 
Preschool for children aged up to 6 years  
where Maori is the only language spoken 
www.kohanga.ac.nz  
 
Barnados 
They offer a home-based child care service in 
Porirua 
www.barnados.co.nz  
 
Inland Revenue Department 
Get an IRD (tax) number before you look for a 
job 
www.ird.govt.nz  
 

http://www.aatraffic.co.nz/
http://www.aatravel.co.nz/
http://www.pukekohetravel.co.nz/
http://www.goldenchain.co.nz/
http://www.mainstay.co.nz/
http://www.yha.co.nz/
http://www.cottagestays.co.nz/
http://www.top10.co.nz/
http://www.thrillseekers.co.nz/
http://www.hrc.co.nz/
http://www.consumeraffairs.govt.nz/
http://www.dhb.govt.ns/tenants-index
http://www.kohanga.ac.nz/
http://www.barnados.co.nz/
http://www.ird.govt.nz/
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 Work and Income NZ 
This is the department that administers core 
benefit assistance and Working for Families 
assistance on low or middle incomes and they 
also help people find jobs 
www.workandincome.govt.nz  
 
Accident Compensation Corporation 
It provides personal injury cover for all NZ 
citizens, residents and temporary visitors to 
New Zealand 
www.acc.co.nz  
 
Te Rauparaha Arena 
It is a multi-purpose venue that hosts many 
corporate and community events in Porirua 
www.terauparaha-arena.co.nz  
 
Upcoming Events 
Porirua City hosts many events including 
sports and concerts. 
www.pcc.govt.nz  
 

 

 
 
 
LOST PROPERTY 
 
 
 

 
Is anyone missing a black cap with Guinness 
written on it? 
 

Also 1 zip-up black XXL knitted crew neck 
cardigan. This has been here since Term 4 of 
last year. 
 

If you think something is yours, then please 
contact a committee person on the back page 
of this newsletter and we can arrange for it to 
be returned to you. 

 
 

 
 

And a great big thank you to Flying Laser 
Colours in Porirua who gave us a box of 
Photocopying Paper 
 

It is very much appreciated! 
 

http://www.workandincome.govt.nz/
http://www.acc.co.nz/
http://www.terauparaha-arena.co.nz/
http://www.pcc.govt.nz/
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A customer who had just received 
a laptop computer asked about 
the power-saving feature known 
as "hibernate. 
 

―Would this hibernate device work in the 
spring and summer, the caller asked. 

 

 
ARE YOU MOVING HOUSE 
OR CHANGING YOUR EMAIL 
ADDRESS? 

  

If you answered ―YES‖, it would 
be much appreciated if you 
would let us know so that we 
can keep our database up to 
date. 
 

And if you know of any other 
SeniorNet member who hasn‘t 

received any notices etc – then please advise 
us. 
 

Our contact details are on the back page of 
this newsletter 
 

 
 
POPULAR NEW ZEALAND MAGAZINES 
 
They will be delivered to you home at a huge 
discount.  
 
ACP Media Ltd has kindly made available this 
exclusive offer to members of the SeniorNet 
Federation 
 
Telephone: 
0800MAGSHOP (0800 624 7467) to order.  
 
You will need to quote 307SNSNZ to get the 
SeniorNet member‘s pricing. 
 
Some of the magazines on offer are: 
Australian Women's Weekly, Cleo, Fashion 
Quarterly, Next, Woman‘s Day, Your Home 
and Garden and many others. 
 

 
 

I used to have a handle on life, but it broke 

SENIORNET LAPEL PIN BADGES 

If anyone is interested in a badge to wear with 
pride at any of our functions, we have some 
for sale at $4.00 each.  Contact a committee 
person on the last page of this newsletter 

 

REMINDER: DAYLIGHT SAVING ENDS ON 
SUNDAY   

 
 
New Zealand Daylight Saving will end on Sunday 
4 April 2010 when 3.00am becomes 2.00am.  
 
People may find it convenient to put their clocks 
back by one hour before going to bed on Saturday 
3 April. 
 

 

TELSTRACLEAR HOME PLAN 
 

(Special Offer for SeniorNet members) 

Maxi speed broadband 

Unlimited calling  
Choice of usage 
Call tollfree - 0508-011-737 
Don‘t forget to quote SeniorNet 
 

 
 
From the Editor – Margot 
 
And another term finishes.  Wow! 
Didn‘t it go fast?   
 

Easter is just around the corner and I have 
been celebrating it for a few weeks now.  
Cream eggs with my cup of tea in the 
evenings 
 
Hope you all have a great Easter break and 
don‘t forget our Open Day on 13 April.  Bring 
a Friend along as well 
 
That’s all for now folks 
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SENIORNET PORIRUA COMMITTEE 2010 

 

 

 
 
 

 

Chair  Peter Badart Ph: 232.8241 pbadart@paradise.net.nz 

Secretary  Laurie Davies Ph: 234.7517 daviess@clear.net.nz 

Treasurer Graham Ellett Ph: 232.6488 ellettg@globe.net.nz  

News Editor Margot Stuart Ph: 236.6217 margots@xtra.co.nz  

Committee Hunt Dryburgh Ph: 234.8139

 hunt.dryburgh@xtra.co.nz  

Committee Lyndel Borrie Ph: 236.7714 lyndel.borrie@ihug.co.nz  

Committee Jim Dearsly Ph: 234.6111 jim.dearsly@xtra.co.nz  

Committee Ron Dunbar Ph: 237.7156 ron-d@slingshot.co.nz   

Committee Peter Phipps Ph: 239.9092 phipps@actriz.co.nz 

Committee Dave Thorpe Ph: 235.7365 d_thorpe@xtra.co.nz  

Committee Colin Young Ph: 233.1067 youngcw@xtra.co.nz  

 

 

Web site Administrator Bob Pretty Ph: 237.9925 bpretty@clear.net.nz   

 www.seniornet-porirua.org.nz 

 

 
 

OUR CONTACT DETAILS 
 

Postal: SeniorNet Porirua 
 PO Box 50.034 
 Porirua 5240 
 
Premises: Ngatitoa School 
 Piko Street 
 Titahi Bay 
 

mailto:pbadart@paradise.net.nz
mailto:daviess@clear.net.nz
mailto:ellettg@globe.net.nz
mailto:margots@xtra.co.nz
mailto:hunt.dryburgh@xtra.co.nz
mailto:lyndel.borrie@ihug.co.nz
mailto:jim.dearsly@xtra.co.nz
mailto:ron-d@slingshot.co.nz
mailto:phipps@actriz.co.nz
mailto:d_thorpe@xtra.co.nz
mailto:youngcw@xtra.co.nz
mailto:bpretty@clear.net.nz
http://www.seniornet-porirua.org.nz/
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Phone: 236.5314  (SeniorNet Classroom) 
 
School Phone: 236.7785   
 

 


